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1. MAIN WINDOW 
 
The Main Window is the primary display area for the CEDView application. An image of the 
Main Window, with all of its default contents, is shown in Figure 1 below.  A key feature of the 
Main Window is the interactive map.  The map presents the major features of Harris County and 
the greater City of Houston metropolitan area.  Although it appears similar to a traditional two-
dimensional map, it is actually a three-dimensional geometric model.  Because of the three-
dimensional capabilities, CEDView supports a variety of features not possible with traditional 
flat-map software. 
 
Figure 1 CEDView Main Window 
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1.1 Navigating the CEDView Main Window 
 
There are three primary methods of interacting with the CEDView program: 
 

1. Mouse Commands used in CEDView are typical of those found in other, well-known, 
software packages.  These commands include:  Clicking the mouse buttons, clicking 
mouse buttons with keyboard keys pressed, and dragging the mouse.  Dragging the 
mouse involves moving the mouse with one of the mouse buttons held down. 

2. Pop-up Panels are sub-windows that appear inside of the Main Window.  They can be 
relocated or hidden from view by the user.  These panels serve a multitude of purposes.  
They can: Change the way the map looks, determine which types of CED events are 
displayed on the map, adjust the timeline to show CED activity between specific dates, 
and present detailed numerical information to users that require it. 

3. The Menu Bar appears in the upper left-hand side of the Main Window, directly under 
the title bar.  Items under each menu heading can be revealed by clicking the left mouse 
button on the heading.  To pick a revealed item, click it with the left mouse button. 

 
1.2 Map viewing 
 
Map viewing is accomplished through the use of a “virtual camera” which, in many ways, is 
analogous to a film or video camera.  Associated with the camera is a “focal point” at which it 
always looks.  When the application starts, the focal point is at the center of the map.  The 
camera can be positioned and oriented through four primary camera controls as follows: 
 

1. Aiming changes the location of the focal point.  To aim the camera, place the mouse 
over the desired location on the map.  Next, click the right mouse button with the control 
key pressed.  The focal point will automatically update to the new location. 

2. Zooming allows the camera to move closer to, or further away from, the focal point.  To 
adjust the zoom (range), drag the mouse forwards and backwards with the right mouse 
button pressed and the shift key held down. 

3. Panning allows the camera to rotate horizontally (azimuth) about the focal point.  To pan 
the camera, drag the mouse to the left and right with the right mouse button pressed. 

4. Tilting lets the camera rotate vertically (elevation) about the focal point.  To tilt the 
camera, drag the mouse forwards and backwards with the right mouse button pressed. 
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1.3 Key map cells 
 
The map imagery is superimposed on top of a grid of tiles called key map cells.  Each cell 
represents a ¾ mile by ¾ mile area.  The Harris County region covers a grid of approximately 
84 (east - west) by 66 (north - south) of these cells. 
 
1.4 CED incidents 
 
Centered on each cell is a three-dimensional bar, analogous to those seen in two-dimensional 
bar charts.  The grid, collectively, represents a bar graph spatially distributed across Harris 
County.  The height of each bar is determined by the number of CED incidents that occurred 
geographically inside the cell.  Each bar has one or more tick-marks along its sides. These 
marks indicate the current number of incidents tallied for that cell. 
 
1.5 Selection 
 
Users can also get detailed information about CED incidents in a cell via Selection.  To make a 
Selection, point the mouse at the top of a bar on the map.  Then, click the left mouse button 
while pressing the control key on the keyboard.  Key map cells are the smallest selectable area 
on the map. 
 
1.6 Quick reference guide 
 
To access an on-line quick-reference guide for viewing and selection controls, choose About 
from the Help menu. 
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2. MENUS 
 
2.1 File Menu 
 
The File Menu allows the user to perform CED database input and output related tasks.  Figure 
2 has an image of the File Menu which has six items: 
 
Figure 2 CED File Menu 
 

 
 
2.2 Load Data 
 
Selecting Load Data brings up an Open File dialog box that allows the user to select a CED 
database to load.  The default file, ced_0208.ced, can be found in the data directory of the 
standard distribution folder.  This file is packed and encrypted in a secure format that can only 
be read by the CEDView software. 
 
2.3 Generate Data 
 
Should a CED database be unavailable, the Generate Data item can be selected to have the 
application randomly fabricate a set of representative CED events.  This item allows for a 
demonstration of the software capabilities without requiring the disclosure of sensitive HPD 
information. 
 
2.4 Save Snapshot 
 
The user can capture the current contents of the Main Window to a Windows Bitmap image file 
(BMP) by selecting Save Snapshot.  In addition to saving the map, all open panels are saved in 
the capture as well if the video display driver supports it.  A panel not needed in the output 
image file can be closed and hidden from display.  The saved bitmap image can be printed, 
shared via e-mail, or used with other software for further processing/analysis.   
 
2.5 Export CSV 
 
Export CSV allows the user to save a Comma Separated Value (CSV) file containing an 
unencrypted, human-readable, report of all records currently loaded into the program.  It will 
export reports for databases loaded with the Load Data menu item as well as databases 
generated with the Generate Data menu item. 
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2.6 Print 
 
The Print menu item captures exactly the same information as Save Snapshot but sends the 
image directly to a printer instead of to a file.  The software will automatically scale the image to 
the printer resolution.  In most cases, however, printing in landscape mode results in a better 
quality hardcopy. 
 
2.7 Quit 
 
The program can be terminated at any time via the Quit menu item.   
 
Location, Time, and Query Menus 
 
Figure 3 is an illustration of the Location Menu, Time Menu, and Query Menu.  The intent of the 
three menus is primarily to provide support for a user who is using the tool as a presentation 
platform.  The idea is to have several events of interest ready to be called upon in rapid 
succession, assisting in situations where a presenter must provide a great deal of information in 
a short time. 
 
Figure 3 Location Menu, Time Menu, and Query Menu 
 

    
 

 
2.8 Location menu 
 
The Location Menu allows a user to set the “virtual camera” focal point to a predefined location 
on the map.  Selecting Default Location restores the view to the center of Harris County.  Saved 
Location is a temporary placeholder for the first user-defined location (currently undefined). 
 
2.9 Time menu 
 
The Time Menu gives a user the ability to skip forwards or backwards to preset times in the 
timeline.  Choosing Default Time resets the current time to the first time in the currently loaded 
CED incident database.  Saved Time is a temporary placeholder for the first user-defined time 
(currently undefined). 
 
2.10 Query menu 
 
The Query Menu allows a user to rapidly set the fields of the Query Panel to a predetermined 
query.  Picking Default Query sets each of the fields in the Query Panel to the value ALL, thus 
returning it to its default state.  Saved Query is a temporary placeholder for the first user-defined 
query (currently undefined). 
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3. PANEL MENU 
 
The Panel Menu allows the user to show panels that are currently hidden from view.  Figure 4 is 
an image of the Panel Menu which has four items. 
 
Figure 4 Panel Menu 
 

 
 
By default, all panels except for the Info Panel are visible when the program starts.  To hide a 
panel, click the small red box ( ) in the upper right hand corner of the panel. 
 
3.1 Show GIS Panel 
 
To reopen the GIS Panel select Show GIS Panel from the Panel Menu. 
 
3.2 Show Query Panel 
 
To reopen the Query Panel select Show Query Panel from the Panel Menu. 
 
3.3 Show Timeline Panel 
 
To reopen the Timeline Panel select Show Timeline Panel from the Panel Menu. 
 
3.4 Show Info Panel 
 
To reopen the Info Panel select Show Info Panel from the Panel Menu, or make a Selection with 
the mouse. 
 
Each panel can be moved around inside the Main Window.  In many cases, panels must be 
moved to uncover parts of the map they obscure.  To drag a panel, place the mouse over the 
panel name and move the mouse while holding down the left mouse button.  For a layout that 
works well, place GIS Panel in the upper right, the Query Panel in the lower right, and the 
Timeline Panel in the lower left of the Main Window.  Panels will remember their positions when 
hidden. 
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4. GIS PANEL 
 
The GIS Panel allows the user to modify the map displayed in the Main Window.   Figure 5 is an 
image of the GIS Panel which consists of three major components: The Overlay check-box 
group, the Map drop-down menu button, and the Selection drop-down menu button. By default, 
the panel is configured to show the base-map with major roads, highways, and highway labels 
displayed. 
 
Figure 5 GIS Panel 
 

 
 
4.1 Overlay check-box group 
 
As seen above, the Overlay check-box group allows the user to add additional map information 
to either the base-map or City Council District map.  The user can add a feature to the map by 
clicking the left mouse button on its check-box.  Currently supported features include: ZIP codes 
and ZIP code labels, major roads and their labels, highways and their labels, HPD station 
locations and their labels, and finally, hospital locations and their labels.  The term “label” is 
synonymous with “name”. 
 
4.2 Map drop-down menu button 
 
The Map drop-down menu button, shown in Figure 6, allows the user to select between a base-
map and a City Council District map.  The base-map shows the major topographic features of 
Harris County.  These features include: the county boundary, major bodies of water, and the 
urban areas of the City of Houston.  The City Council District map contains the same features as 
the base-map, but also includes labeled and color coded Houston City Council Districts. 
 
Figure 6 Map drop-down menu button 
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4.3 Selection drop-down menu button 
 
The Selection drop-down menu button allows the user to choose the type of highlighting they 
want to see on the map when a selection is made.  The drop-down menu button has three 
options: Key map, City Council District, and ZIP code.  Figure 7 shows the Selection drop-down 
menu button.  When a key map cell, City Council District or ZIP code is selected, it will appear 
darker on the map. 
 
Figure 7 Selection drop-down menu button 
 

 
 

 
4.4 Keymap Selection 
 
A Key Map selection highlights only the key map cell selected by the user.  Key map is the 
default highlighting method. 
 
4.5 City Council Selection 
 
City Council District selections highlight all of the key map cells in the selected City Council 
District. 
 
4.6 Zip Code Selection 
 
ZIP Code selections highlight all of the key map cells in the selected Zip Code. 
 
5. QUERY PANEL 
 
The Query Panel provides the user with options for selecting which CED events are displayed 
on the map.  An image of the Query Panel is illustrated in Figure 8.  The Query Panel has four 
major sections: The Shift and Division drop-down menu buttons, the Outcome group, the Officer 
group, and the Suspect group. 
 
Figure 8 Query Panel 
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There are several special values than can be selected in the drop-down menu button items of 
the query panel.  A field with value “ALL” will match any value for that field in the database of 
CED incidents.  Its use is to indicate that the user has no particular preference for a field.  It is 
also the default value for all fields in the panel.  The value “Dog” is used when a dog or other 
animal is involved in a CED incident.  Fields with a value “Duplicate” imply that a CED event 
was recorded more than once in the database.  This is due to the fact that some events involve 
multiple officers reporting the deployment of a CED.  Finally, the value “Officer” is used when an 
officer is involved as the suspect in a CED incident. 
 
5.1 Shift drop-down menu button 
 
The Shift drop-down menu button, shown in Figure 9, allows the user to select CED events 
based on the shift in which they occurred.  It has three possible values: Day, evening and night. 
 
Figure 9 Shift drop-down menu button 
 

 
 
 
5.2 Division drop-down menu button 
 
The Division drop-down menu button, shown in Figure 10, lets the user restrict displayed events 
to only those involving officers from one of 19 HPD divisions. 
 
Figure 10 Division drop-down menu button 
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5.3 The Outcome group 
 
The Outcome group provides a method for filtering displayed events based on their outcome.  
The Outcome group contains two drop-down menu buttons, depicted in Figure 11 
 
Figure 11 Outcome group drop-down menu buttons 
 

   
 
5.4 Successful drop-down menu button 
 
Incidents where a CED unit was successfully deployed, or where one was not, can be seen 
using the Successful drop-down menu button. 
 
5.5 Injury drop-down menu button 
 
The Injury drop-down menu button provides a way to view instances where either an officer, 
suspect, or both sustained injury due to the use of a CED. 
 
5.6 The Officer group 
 
The Officer group allows a user to display events based on the demographics of the officer(s) 
involved.  The Officer group contains four drop-down menu buttons, shown in Figure 12. 
 
Figure 12 Officer group drop-down menu buttons 
 

       
 
5.7 # Of drop-down menu button 
 
The # Of drop-down menu button selects incidents by the total number of officers present at a 
scene where a CED was used. 
 
5.8 Race drop-down menu button 
 
The race of the officers(s) involved in a CED event can be selected via the Race drop-down 
menu button. 
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5.9 Gender drop-down menu button 
 
The Gender drop-down menu button filters events based on the gender of the officer(s). 
 
5.10 Response drop-down menu button 
 
CED events in which the officer(s) initiated action, was/were dispatched to the scene, or both 
can be viewed by changing the Response dropdown. 
 
5.11 The Suspect group 
 
The Suspect group offers a way of choosing events to display based on the demographics of 
the suspect(s) involved.  The Suspect group consists of five drop-down menu buttons depicted 
in Figure 13. 
 
Figure 13 Suspect group drop-down menu buttons 
 
 

        
 

  
 
The # Of, Race, and Gender drop-down menu buttons serve the same purpose for suspects as 
they do for officers in the Officer group. 
 
5.12 Age drop-down menu button 
 
The Age drop-down menu button groups suspects involved in CED incidents into one of eight 
age ranges.   
 
5.13 Reason drop-down menu button 
 
The Reason drop-down menu button filters incidents based on the reason provided by the 
officer(s) for deploying CED devices on the suspect(s). 
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6. TIMELINE PANEL 
 
The Timeline Panel allows users to dynamically display CED incidents that occur between two 
specific points in time on the map.  These two times are known as the “start time” and the 
“current time”.  By default, the start time is set to the first time present in the database.  Figure 
14 is an image of the Timeline Panel, which has three primary areas of interest: The Time/Date 
Display, the Tape Deck, and Fine-Tuning Controls. 
 
Figure 14 Timeline Panel 
 

 
 

6.1 Time/Date display 
 
The Time/Date Display is visible in the lower right-hand corner of the Timeline Panel.  It shows 
the current date and time the software is using to select CED incidents for display on the map.  
It has the following format: Shift, month, day, and year.  The current date and time are updated 
by user interaction with the mouse, Tape Deck or Fine-Tuning Controls.  The Time/Date Display 
will rollover if the user attempts to set it to anything beyond the night shift of December 31, 
2031.  It will also roll-under if the user attempts to set it earlier than the day shift of January 1, 
2000. 
 
The user can control forward and reverse playback with the mouse.  Dragging the mouse to the 
left, with the left mouse button down in the main window, controls reverse playback.  To drive the 
timeline forward, drag the mouse to the right in the main window with the left mouse button 
down.   
 
6.2 Tape deck 
 
The Tape Deck derives its name from its similarity to an audio/video cassette player.  It consists 
of:  a set of three radio-buttons, a Timeline Indicator bar, and a variable Playback Rate drop-
down menu button. 
 
6.3 Radio buttons 
 
The three radio-buttons are mutually exclusive and selecting one will de-select either of the 
other two.  By default, the Pause Button ( ) is selected indicating that playback of CED 
incidents is halted.  Click the Forward Button ( ) to play events forwards from the current time.  
Click the Reverse Button ( ) to play events backwards from the current time. 
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6.4 Timeline indicator bar 
 
The Timeline Indicator bar depicts, for the user, where in the timeline the current time/date falls.  
The user has reached the end of the timeline when the blue bar extends all of the way across its 
gray container, as shown in Figure 15. 
 
Figure 15 Timeline Indicator bar 
 

 
 
6.5 Playback rate drop-down menu button 
 
Playback will occur at the rate specified in the Playback Rate drop-down menu button depicted 
in Figure 16.  The drop-down has 4 possible rates: Shift, day, month, and year.  The default 
value is day, and can be changed on-the-fly while either forward or reverse playback is 
occurring.  The Playback Rate drop-down menu button also sets the playback rate for mouse-
controlled playback. 
 
Figure 16 Playback rate drop-down menu button 
 

 
6.6 Fine-tuning controls 
 
The Fine-Tuning Controls are provided so that users can make very specific adjustments to the 
timeline.  They consist of a set of: Increment Buttons ( ), Decrement Buttons ( ), and a Range 
Button ( ). 
 
There are four separate increment/decrement button pairs, one for each component of the 
current time/date.  To move the shift, day, month or year forward by one unit, click on the 
individual Increment Buttons.  To move them backwards by one unit, click on the appropriate 
Decrement Buttons. 
 
Only CED incidents occurring between the start time and the current time are considered for 
display on the map.  The user can click the Range Button to set the start time to the current time 
indicated in the Time/Date Display.  When done, only CED events occurring on or after the new 
start time are considered. 
 
The Timeline Indicator bar will turn orange if the user sets the current time to a time earlier than 
the newly selected start time.  To reset the start time to the first time in the database, select 
Default Time from the Time Menu. 
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7. INFO PANEL 
 
The Info Panel provides detailed information about each selection made by the user.  If the 
panel is not visible when the user makes the selection, it will automatically be displayed.  Figure 
17 illustrates an image of the panel which has three components:  The Text Area, the Clear 
Button, and the Save Button.  Information displayed in the Text Area depends on the time/date 
chosen in the Timeline Panel and the specific query options enabled in the Query Panel. 
 
Figure 17 Info Panel 

 
 
7.1 Text area 
 
For each selection, a series of lines are printed into the Text Area: 
 

1. Two lines specifying the start time and current time of the query. 
2. The total number of CED incidents occurring, for that query, Citywide. 
3. The selected key map cell, along with its count and its percentage of the Citywide total.   
4. Totals for ZIP codes contained in the key map cell, along with their percentages.   
5. Tallies for City Council Districts present in the key map cell with their percentages. 

 
Some key map cells contain multiple ZIP codes and/or multiple City Council Districts.  As a 
result, there may or may not be multiple listings for each. 
 
Data from multiple selections are recorded in the Text Area in the order the selections were 
made.  When the visible portion fills with text, previous data will scroll out of view.  A scrollbar 
will then appear on the right-hand side of the Text Area.  To see results from previous selections, 
drag the scrollbar upwards with the mouse or use the arrow at the top of the scrollbar.  Dragging 
the scrollbar downwards, or clicking the arrow on the bottom of the scrollbar, will bring data from 
more recent selections back into view.  Making another selection will always cause the Text 
Area to jump back to the most recently printed information. 
 
7.2 Clear button 
 
The Clear Button removes all selection information from the Text Area, returning it to its default 
state. 
 
7.3 Save button 
 
The Save Button allows a user to save information currently recorded in the Text Area to a file 
on disk.  Both buttons can be used, in combination, to create a simple data file of CED incident 
details.  This file can be printed, shared via e-mail, or used with other software for further 
processing/analysis.
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8. EXAMPLE 
 
Below is an example that is provided to illustrate some of the concepts and graphical user 
interface components previously described in detail.  As can be seen in Figure 18: 
 

• The user has taken a 3-point perspective, close-up view centered north of City Council 
District D inside Loop-610. 

• The City Council District map is selected in the GIS Panel. 
• Highways and highway labels are the only overlay items in use. 
• Key map is the current selection mode. 
• The current query involves all shifts of the South Central division. 
• The user is looking for any events in which a Hispanic, female Officer has deployed a 

CED on an Asian, male suspect 16 years old or younger. 
• The current timeline under consideration ranges from the evening of January 4, 2000 to 

the evening of January 14, 2031. 
• Key map cell 533D has been selected which contains ZIP code 77004 and is part of City 

Council District D. 
• There was only one CED event that matched all of these criteria indicated in the Info 

Panel 
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Figure 18 Example of output from CEDView software 
 

 
 
 
 

 17


